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Warranty 
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Technical Support 
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as possible when they are discovered. 
 
Liability 
 
Rowny Systems, Inc. dba Antigen Plus and its distributors assume no responsibility for the use of 
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program including establishing appropriate protocols and validation procedures to ensure accurate 
data entry. ANTIGEN PLUS makes no decision or final recommendation on the meaning of test 
results or on patient care. 
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Introduction	
 
Antigen Plus is a red blood cell inventory and antigen search program that allows the user to enter 
test results that are automatically evaluated to assist with the interpretation of those results.  It is 
designed to permit fast and easy data entry of test panels, and to search the data for any 
combination of antigens you choose.  It is intended to quickly select donor cells with particular 
phenotypes for antibody identification studies and to speed up the interpretation process for the 
blood bank technologist.  
 
The data stored for each donor are: 
Donor ID 
Optional Donor Note 
Lot Number 
Vial Number 
Expiration Date 
Optional Retesting Information on expired cells 
Supplier Name 
Location (optional) 
Phenotype Designation 
Sex 
Blood Group 
28 Principal Antigens Phenotype 
Additional Antigens - user-defined special typings 
Frozen flag 
Out-of-Stock flag 
  
 
Data that can be stored for a patient are: 
 ID number *  
 Name (First*, Middle, Last*) 

Date of birth 
 Short note to appear on the screen or on saved panels  
 Description on a saved panel 
         *required fields 
 
Data that can be stored on a saved panel are: 
 All the data described above 
Test results (negative or positive reactions to donor cells and check cells (optional for self-defined 
columns) recorded on a Results Worksheet 
Test results evaluations 
Name of technologist and dates of test for each Results column 
Name of up to two panel reviewers 
 
The user may specify any combination of antigens to search for, search the data and select any 
cells desired, enter test results, and print a selected panel or results panel worksheet, and save a 
panel if a patient is selected. The user may store and retrieve the selected panels with any test 
results as desired. Antigen Plus Version 7.5 must be run from inside Microsoft Windows Vista or 
later.  It requires a printer that can print in Landscape format (11 x 8½).   
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Validation	
 
Antigen Plus provides a template for validation of the software based on the NCAALS format on 
its website www.antigenplus.com.  It is intended to be modified to meet the protocols and 
standards of the individual institution, but may be reliably used as is to validate the software.  
Antigen Plus provides technical support for this process.   
 
The panels provided are electronically verified to match with the specification sheets provided by 
the supplier. The phenotypic information printed on a selected or results panel can be validated by 
assuring that its data exactly match the data from the suppliers.  Part of a laboratory’s validation 
procedure should be to print several lot panels and have the responsible technologist compare 
them with the supplier’s data sheets. 
 
Antigen Plus makes no decision or final recommendation on the meaning of test results or on 
patient care - this is the user’s responsibility.  Antigen Plus uses the logic recommended by the 
American Association of Blood Banks to evaluate initial test results in the same way a 
technologist would do. 
 
 

Installation	
 
If you are Upgrading from a Version Earlier than AP7.5 
 
Please email your current database (AP6.mdb or AP7.mdb) to 
customerservice@antigenplus.com .  We will convert those data to the new version and 
populate the new database when you install the program for production. 
 
 
Install .NET Framework 4.5 
 
.NET Framework 4.5 is required. The latest version is actually 4.5.1, and this is the 
version we recommend. The general download page is: 
 
 http://msdn.microsoft.com/en-us/library/5a4x27ek(v=vs.110).aspx 
 
This page links to an offline installer which can be placed on CD or USB key and 
installed without an internet connection. 
 
 
Run Windows Update 
 
If .NET Framework was installed, we recommend immediately running Windows Update 
to upgrade these products to the latest versions. 
 
In the Cloud—you will be prompted for a log-in and password to use Antigen Plus stored 
for you on our cloud server when you are using the on-line version of the software. 
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To install Antigen Plus on your desktop, you must download the program from 
http://clickonce.antigenplus.com/clickonce/AntigenPlus.application  
Register, and then wait for us to create a database and notify you that the program is ready to 
go. The first person to use Antigen Plus once you are set up will have administrator 
privileges and should accomplish a few tasks before other users are given their log-ins and 
passwords. 

Firewall	Issues	
In order to communicate with the Antigen Plus servers, the Antigen Plus Cloud 
application needs access to the following outgoing network port: 
gateway.antigenplus.com port 443 

Encryption	of	Patient	Data		
 
Encrypted data cannot be read by us on our server where your database is stored. The 
patient information key that the program creates on your end ensures that the data will be 
readable to anyone who logs in with the appropriate user name and password. Saving that 
key to a secure location ensures that your data will be recoverable in its unencrypted form 
in the event of a computer failure on your end. It is therefore VERY IMPORTANT that 
the first user open the File menu and click on the Save patient information key tab to save 
the key to a secure location. You should be aware that anyone with administrator 
privileges will be able to save that key again at any time in the future. 

To	Run	the	Program	
 
Double click the Antigen Plus icon to start the program. When the program loads, select 
the Options menu at the top of the screen.  Type in the name and address of your facility 
as you want it to appear on all the printouts generated by the program.   
 
As the first person to use the program, you will be logged in with your current Windows 
login and have administrator rights.  If others share your log in, you should assign 
yourself a username and password, and, in any case, give yourself initials for use in the 
program.  To do this, open the Users menu and open Account Settings and enter name, 
password, and initials (if you are the only one who uses this Windows login, a password 
is not necessary as long as you keep Login automatically from Windows account 
checked. 

Logging	Others	In	
 
In a network environment, you may automate the log in to Antigen Plus to match the 
Windows log in of each user. This will maintain a record of each individual user as long 
as everyone has a separate login to Windows.  If users are sharing a Windows login, 
individual user accounts should be set up. Open the Users Menu | Maintain Accounts and 
enter information for each user. Users can change their passwords after logging in. 
Once the password protocol is established, each user and/or pc should download the 
program from http://clickonce.antigenplus.com/clickonce/AntigenPlus.application 
and go to the login screen and put in the company name and password (and their own if that 
applies).  
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Menus	
 

File	Menu	
 
The File menu accesses six functions, Import Data, Refresh Data, Company login 
information Backup, Backup patient information key, and Exit. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Import Data allows the importation of commercial lots 
from the internet, the importation of panels in Antigen Plus 
format from other sources.  
 
 
Refresh Data  If you are doing a search and another user is  
downloading or entering cell data at the same time, Refresh 
Data will ensure that the new data are available to you 
search. 
 
 
 
 
Backup prompts you to select a location to back up all of your Antigen Plus data. This 
feature was designed for a local network installation and is only useful in the Cloud 
Version as a fail-safe back up in the highly unlikely case of a massive multiple system 
failure both in our backup facilities and in Microsoft Azure.  Should such a catastrophic 
failure occur, we could use this back up to restore your data on our server for you to use  
if you are running on a local database (only one computer is accessing Antigen Plus).   
 
Backup patient information key is available only to an administrator and allows the 
storage of the key that is vital to accessing your patient information in the database.  We 
recommend that this back-up is kept in multiple secure locations. 
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Options	Menu	
 

	
 

System Options 
 
The System Options menu allows you to set and/or change general default parameters for 
using Antigen Plus in your lab. There are three 
tabs on this menu—one each for General, Search, 
and Printing options. 
  
In the General tab, the first option sets the 
display order for cells on the Search Screen.  The 
antigen array of whichever manufacturer (or 
alternative) will be the one you use for searching, 
selecting, and entering your test results. 
      
  
 
 
 
 
 
 
The second option allows you to view your selected cells in one of three sorted orders. 
 
The third option allows you to select one of two scoring systems for entering your test 
results. 
 
The fourth option option activates an automatic check for duplicate cells when you are 
downloading commercial red cell panels.  If you chose this option, when you download a 
panel, you will be alerted to the existence of duplicate donor cells in your database and be 
given the option to ignore them, mark them out-of-stock, or delete them (as long as they 
are not in any worksheet that you have saved).   
Please note:  If you are importing two identical panels (e.g. Quotient panels that are 
the same except that one is enzyme treated), both panels will be marked out-of-stock 
if you have this feature turned on and choose the out-of-stock option 
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In the Search tab, the first option 
allows you to include out-of-stock cells 
in your searches.   
 
The second option allows you to 
prioritize your search by a single 
supplier.  Normally, when cells are 
searched, the search order is freshest to 
oldest to frozen.  This option allows 
you to find all the cells from one 
supplier in that order before other cells 
are found.   This feature is designed to 
make cell selection easier for those labs 
that rely most heavily on a single 
supplier or test system and would 
prefer to test those cells unless none are 
available with the required 
characteristics. 
 
The third option activates the search by 
donor note function on the Search screen.  The text box on the screen will search donors 
by whatever text is in an associated note.  This is primarily useful for reference labs with 
frozen inventories of rare cells and cells they have typed and frozen themselves 
 
The fifth option--Search automatically when search criteria change--removes the Search 
button from the Search Pattern screen.  When this is done, cells matching each criterion 
entered are found and displayed.  As more criteria are added, the cells change to match 
the cumulative pattern.  Hospitals and blood banks with an inventory of fewer than 200 
cells may find it more convenient to search in this manner as it eliminates the necessity of 
hitting the search button to initiate a search. 
 
In the Printing tab, the first option allows you to enter text that will be printed on any 
printed output to identify your facility.  
There are no limits to the amount of text 
you can enter, but filling more than the 
space available will result in overprinting 
issues.  Limiting the second line even more 
will ensure that the patient name and date 
of birth will not be truncated on the printed 
panel 
 
The second option allows you to print 
signature review lines on the bottom of the 
printed selected panel if you are doing 
manual rule-outs. 
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The third option allows the Selected Cell Panel to print in the format used in Version 7.4.  
This is to satisfy SOP requirements of reference labs that have been accustomed to this 
format. 
    
The fourth option enables the printing of extended information about each donor cell on  
panel at the end of a selected panel or worksheet. 
 
The final system option eliminates the text in the first column of a printed Selected Panel 
–the selection order number and any out of date or frozen designation will appear on the 
screen but not on the printout to allow space for manual notes. 

Customize	Results	Columns	
The Results columns default to IAT, ENZ, DTT, 
and A, B, C, and D respectively.  A,B,C, and D 
columns exclude by the same rules as IAT, and 
those columns may be renamed and all the 
columns may be repositioned from the Options 
Menu as default settings.  Names are suggested 
for the columns but you may type any text in the 
column header box that you choose.  Check cell 
status may be selected for any of the columns and 
the check cell threshold for all columns may be 
set. 

Rare	Cell	Inventory	
This option calls up a list of all the special typings (additional antigens) in your database.  
You may search for all or some of them and print out a report. 

 
 
 

 
View Menu 
 
 
 
 

 
Since BioTest has added Coltons and Diegos to their standard array and Quotient has 
added Wra, these additional antigens will not appear on the rare cell inventory list but can 
be enumerated by searching for them on the Search screen. 
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Donor	Note	
When a donor is selected on the Add/Edit screen, the donor note option allows a note to 
be inserted that will stay with that donor number (regardless of lot number) until it is 
removed. 
 

 
 
The donor note will be displayed with the cell on the Add/Edit or Search screens. 

 

Patients	
The patients menu opens the Maintain Patients screen where patient information may be 
entered or edited. 
 
The search feature on this screen enables a search by any of the criteria in any of the 
columns.  Clicking in any cell opens it for editing. 
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Suppliers	
 
This option allows entry of a supplier other than the currently licensed commercial red 
cell manufacturers.  This is primarily for reference laboratories who are typing their own 
cells or receiving cells from other sources.  Any of the available antigen arrays may be 
associated with the new supplier. 
 
 
 
 
 
 
 
 
 
  



10 
 

Lot	Menu	
 
 
 
 
 
 
The Lot menu connects you with the Antigen Plus server for download of commercial red cell 
panels (see Downloading Lots on p. 28), and allows for preview or printing of any lot that is 
selected on the Add/Edit screen. 
 
Selecting Maintain Lots opens the Maintain Lots table.  On this table you can delete one or more 
lots (as long as they have not been used in any saved work in the last ten years) by highlighting a 
row (or highlighting several rows by holding down the CTRL key) and clicking on Delete 
Selected Lots.  You may also mark any lot as out-of-stock or enzyme treated.  A lot that is in-
stock but has one or more cells that are out-of-stock will be marked with a square rather than a 
check mark in the box.  Lots can be sorted in forwards or backwards Lot Number or Expiration 
Date order by clicking at the top of the column. 
 

 
If you attempt to delete a lot that has been used in a saved workup, you will be notified 
that the saved work must be deleted before the lot can be deleted.  Deletion of saved 
work-ups may only be done after ten years have passed since the panel was saved.  If it is 
too early or you do not wish to delete the work and the lot, you may mark the lot as out-
of-stock thus removing it from searchable inventory while saving any work that has been 
done with it. 
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Panel	Menu	
 

 
The Panel Menu brings up a variety of options that 
are the most frequently used in Antigen Plus. 
If those options are unavailable (i.e. there are no 
cells selected), they will be greyed out on the 
screen. 
 
 
 

 

Load	Saved	Panel	
 
This option opens up a table of all saved work-ups (any selected panel that has been 
saved with or without test results) 
 
A saved panel may be retrieved for further work or review by selecting its row and 
pressing Load or by double-clicking on the row.  Once the saved panel is retrieved, all of 
the information it was saved with will populate the appropriate screens (Search, Selected 
Cells Worksheet, and 
Results Worksheet). 
 
A saved panel may 
also be deleted from 
this table if it is ten 
years old—a 
confirmatory warning 
will appear after 
Delete is selected.    
 
You may save a 
Selected Panel (with 
any results included) 
from this screen.   
 
As this can be done more directly from the Selected Cells Worksheet or Results 
Worksheet, the function is here so that you may remember to save current work when 
you are loading another panel (there will also be a warning when you are loading a new 
panel that one is already in use). 
 
Selecting Clear Selected Cells Panel will clear all selected cells from the screens.  
Current work will not be saved. But if the panel was previously saved it will remain in 
the database. 
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Selecting Selected Cells Worksheet or Results Worksheet will call up the current work 
and open those screens. 
 
	

User	Menu		
 
 
 

	

	

	

	
Any user can change his or her won password.  That change can be overridden by an 
administrator changing that user’s password. 

Account	Settings		
 
This window allows a user to change name, initials and password.  Administrators can 
also assign administration rights from this window.  A new user may not log in until an 
administrator has added him or her in the Maintain Accounts table. 
 
Administrator with Automated Windows Log in Account Settings—see p.19 
 
Administrator Account Settings            User Account Settings 

 
 
 
 
 
 

Logout      Logs the current user out and asks for a username and password to continue. 
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Maintain	Accounts	
 
This menu is available only to administrators and is used for managing user access to 
Antigen Plus.  If Automatically create accounts from Windows Login is checked, 
Antigen Plus will recognize the user from that user’s log in to Windows and require a 
password if the Windows login also requires it. 
 
 
 
 
 
 

	
 
 
 
 
 
 
The possible roles an Administrator can grant another user are: 
Administrator: Can maintain users, can save panels, can review panels tested by self or 
another technologist, can edit cells, and can edit patient information. 
Full access: Can save panels, can review panels tested by another technologist, and can 
edit cells. 
Save panels: Can save panels. 
Read only: Cannot make changes. 
Each user can change their own password. 
 

Authenticating	Users	
User	access	
 
After database access is granted, Antigen Plus authenticates and authorizes the user 
within the software itself. Antigen Plus provides two different methods for authenticating 
users of the software: 1) Windows Active Directory authentication, and 2) usernames and 
passwords. You can use one of these methods exclusively, or use them in combination. 
 
Most sites will find it easiest to use Windows Active Directory authentication, and that is 
the default. In this mode users are identified by their Windows login, and no additional 
authorization is required. If Automatically create accounts from Windows logins is 
checked in the Maintain Accounts window, then new Antigen Plus accounts will be 
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created automatically whenever a new Windows user launches the software. Window 
Active Directory authorization can be enabled or disabled for a particular user using the 
Login automatically from Windows account checkbox in the Account Settings 
window. 
 
If Windows Active Directory authorization fails, is disabled, or the user logs out of the 
software, then the user will be presented with a username/password dialog box to login. 
This password is maintained within Antigen Plus itself, and is distinct from the user’s 
Windows account password. 
 
If your site wants to require a separate username/password login each time Antigen Plus 
is launched, this can be accomplished by: 
 

1. Unchecking the Automatically create accounts from Windows logins box in 
the Maintain Accounts window. 

2. Unchecking the Login automatically from Windows account box or deleting 
the user’s Windows account from the Account Settings window. 

	
View	User	Activity	Log	
 
An administrator will have this feature enabled and selecting it will call up a log of all 
user log-ins and all activity involving patient information.  This log is exportable in a csv 
format. 
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Security	Settings	for	Time	Outs	and	Username/Password	Mode	
 
 
Timing out:  if you would like to have the program shut down if left unattended, check 
the box next to “Exit the 
Application…” and set your 
time parameter.  If a user leaves 
the program unattended for that 
length of time, the program will 
shut down and that work will 
reappear only when that user 
logs back in. This option is 
available for both automated and 
manual password access. 
 
 
 
 
 
 
The other options are for manual password configurations and are activated by checking 
the boxes on the right of the options and setting the desired parameters to the left. 
 
 
 

Help	
 
The Help Menu makes text regarding the use of Antigen Plus available to the user.  That 
text is reproduced in this manual in the appropriately named sections. 
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Operation	
 

Downloading	Lots	from	the	Internet	
 
Initially, you must have entered some text identifying your laboratory in menu 
Options|Text to appear on printed Cell Lot panels and Selected Panels.  You should 
ensure that your workstation has a working connection to the internet.  The first time you 
press Lot/Download Lots from Internet, Antigen Plus will automatically be notified, and 
will contact you when the subscription is activated.  Once the subscription is established, 
you will see the following screen: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Available panels are listed in descending order of Expiration Date.  They may also be sorted in 
ascending order or by Supplier or Lot Number by clicking on the column title.  You may select as 
many as you wish, the number selected is displayed at the bottom of the screen as each panel is 
added to your database when you click Download Selected Lot(s). 
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Downloading	Lots	with	Supplemental	Typings	
 
Immucor provides supplemental unconfirmed typings with some of their panels.  You may 
download some or all of these by selecting the SUT box next to the lot number when you are 
downloading.  You will be given a choice of which typings you wish to see on your downloaded 
cells in a dialog box.  Your choices will remain and may be changed or not the next time you 
download. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Download	Prompt	Option	
If you have selected Prompt when downloading duplicate cells in the System options menu, you 
will be notified whenever donors on the downloading panel exist in your database.  You can 
ignore the notification, mark the duplicate cells as out of stock, or delete them.  If you attempt to 
delete a cell that has been stored as part of a saved panel, you will be advised to mark it out of 
stock instead. 
 
 
 
 
 
 
 
 
 
 
 
Please note:  If you are importing two identical panels (e.g. Quotient panels that are 
the same except that one is enzyme treated), both panels will be marked out-of-stock 
if you have this feature turned on and choose the out-of-stock option. 
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Principal	Modes	of	Operation	
 
 
There are two principal modes of operation: Search and Add/Edit Cells.  You can switch 
between the two modes by clicking the tab in the upper left of the screen.  A menu option is 
selected by highlighting it with the mouse, scrolling to the desired option with the Up and Down 
Arrow keys and pressing enter, or by pressing a letter key matching an underlined letter in the 
menu option.   
 
 
When the program starts, the Search screen will automatically be displayed.  A search pattern 
box allows you to enter a search pattern of the 28 principal antigens and/or any additional 
antigens, search the inventory for matches, and mark cells or lots for inclusion in a selected panel. 
(Some red cell suppliers include additional antigens on their array and some leave off principal 
antigens; those arrays are displayed that way in Antigen Plus if that supplier is chosen.) 
. 
 

 
The search panel will immediately display how many cells are found in your database that are 
matches for your current search pattern, and continuously displays how many cells have been 
selected.  Note that the search pattern defaults to blood group O cells. 
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The Results Worksheet screen can only be activated when at least one cell or lot has been 
selected.    All selected cells will be displayed in the Results Worksheet screen grid.  Next to each 
cell phenotype, seven results columns are provided. 
 

 
 
The default columns are IAT (indirect anti-globulin test), Enz for Enzyme treated cells, and DTT 
for DTT/AET treated cells.  These columns have obligatory check cell results. The remaining 
columns labeled A through D follow the same exclusion rules as IAT, may be renamed to match 
the particular tests you use, and may be given check cell status if desired. 
 
You may use the headings suggested or enter your own and display the columns in any order you 
wish (see the example on the Results Worksheet above) by dragging them across the screen. 
 
Adjustment of results columns is done in Options/Customize Results Columns… see page 21 
The cells displayed on the Results Panel Worksheet will be those currently selected either in the 
Search mode or by using the Add Lot to Selected Cells function on the Utilities menu. 
An autocell row will always display at the end of each Results Panel.   
  
The Results Panel screen cannot be minimized, but clicking on the Exit button at the top of the 
screen will not erase the current results.  All results will be maintained until the Clear Selected 
Cells button on the Search screen or Panel Menu is selected, and its results, with comments, can 
be saved for future reference by going to Panel Menu | Save Selected Panel or the File Menu on  
the Results Panel Worksheet.  Individual cells (and their associated results) can be removed by 
exiting the Results Panel screen and unchecking the cell from the Selected Cells Panel screen.   
 
Instructions for entering test results and an explanation of their interpretation may be found in this 
manual in the section on Evaluating Test Results.  Whenever a reaction is entered into a results 
box (the columns under IAT, Enz, DTT and A-D), those antigens that are ruled out by a negative 
reaction will be shaded, and the number of times an antigen has been ruled out is displayed on the 
bottom line.  The rule-out counts for P1 and Xga are given an asterisk, with an explanation in the 
Evaluation box below.  Positive P1 and Xga antigens require three negative reactions to verify 
their exclusion. 
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Antigen	Order	for	Selected	Cells 
 
The antigen buttons are displayed in a common default order of blood groups: Rh-Hr, Kell, 
Duffy, Kidd, Lewis, P, MN, 
Lutheran, and Sex-Linked.  Some 
suppliers’ data sheets list them in a 
different order, so in order to 
simplify searching, selecting, and 
entering data there are 7 display 
options selectable with the 7 option 
buttons in the Options/ System 
Options menu.  These choices stay 
with any donor displayed in the 
Search mode (if more than one 
supplier is represented, the Additional Antigens box will accommodate any typings missing from 
an array; e.g. if you are using the Immucor order that omits the “f” typing and select an additional 
cell that has this typing, the “f-“ or “f+” will appear in the Additional Antigens box (exclusion 
rules will consider the 28 common typings regardless of where they appear on the screen). 
 
 

Automated	Antigen	Order	on	the	Add/Edit	Screen	
On the Add/Edit screen, the array will match the supplier currently selected and appearing in the 
Supplier Box and will change automatically as the supplier is changed.   
 
You may add a supplier with any one of these arrays from the View Menu. 
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Available	Arrays	
 
Option 1:  BioTest 

 
 
Option 2: Immucor 

 
Option 3: Medion 

 
  Option 4: Ortho 

Option 5: Quotient 

 
Option 6:  Red Cross Preferred 

 
 
Option 7: Standard Hopkins Option 
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Searching	and	Selecting	
 
Search for Match 
 
On the Search screen, the Search Pattern box allows you to search and select lots or individual 
cells. 
 
 
The pattern box contains a Donor ID list box, a Lot Number list box, Sex, Group, Frozen and 
Enzyme Treated buttons, Search and Clear Search Criteria buttons, a row of 28 to 32 Antigen 
buttons and an Additional Antigens box: 

 
Search Pattern 
 
You may search by any of the criteria appearing on the Search Pattern box.  To find a donor, 
select the donor number (and click the Search button if you are using that feature); to find a lot, 
select the lot number (and click the Search button if you are using that feature)—the donor 
phenotype or phenotypes will appear below the Search pattern box and may be selected 
individually or all at once for inclusion in a Selected Cell and Results Worksheet Panel.  To enter 
a search pattern, click the desired antigen buttons in the search pattern box.  You may set the 
buttons to 0, +, or blank.  A 0 or + setting means that a matching cell must have a 0 or + in the 
same place (s or w designations will be read as + during a search).  A blank setting means “don’t 
care”, and during a search those antigens will be ignored.  To search for frozen cells only, click 
the Frozen button. To search for enzyme treated cells only, click the Enzyme Treated button. To 
search for a particular blood group, click the Group button until the appropriate group designation 
appears.  To add additional antigens to the search pattern, check those desired in the Additional 
Antigens box by selecting the arrow on the right of the box to drop down a list of all the 
additional antigens in your database.  You may select as many additional antigens as you like, but 
only the first 8 to 10 (depending upon their length) will display on the screen and an ellipsis will 
indicate that more are selected.   If you mouse over any of the selected antigens or the ellipsis, a 
box containing all of your selected antigens and their associated ISBT numbers will appear.  
 
A table of ISBT numbers used in Antigen Plus can be found in the 
Appendix. 
 
 
 
 
 
 
 
To remove Additional Antigens from the search display box, uncheck the item(s) in the 
Additional Antigens drop down list. 
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Searching 
 
To perform a search, enter your search criteria (and click the Search button if you have not 
checked Search automatically when search criteria change in System Options--see p.21). The 
system will search your inventory for a cell which matches ALL the +, 0, and Additional 
Antigens in your search pattern; s or w are recognized as positive during a search.  When you 
search, the inventory will be searched starting with the NEWEST cells first, that is, in reverse 
expiration date order.  All frozen cells have no expiration date and will be gathered at the END of 
the search order unless you have specified a preferred supplier (see System Options) in which 
case all cells from that supplier will be found first in reverse expiration order and be followed by 
all other suppliers in reverse expiration order.   
 
A search for an unspecified blood group (blank) will match ANY blood type, specified or 
unspecified.   
 
A search for Frozen will return any frozen cell with any other criteria you have entered. 
 
A search for Enzyme Treated will return any enzyme treated cell with any other criteria you have 
entered. 
 
If you have activated the Search by Donor note function, you may enter any text in the donor note 
search box and only cells with donor notes containing that text will be selected. 
 
If you have a donor number displayed in those boxes, only that cell will be found.  Clicking on 
any other search criterion will remove that donor number from the box.  If you have a lot number 
displayed, a cell or cells with that lot number with any other criteria you have entered will be 
found. 
 
As soon as you enter search criteria (or click on the Search button), all cells matching the criteria 
you have entered will be displayed beneath the Search Pattern box.  The full phenotype of each 
cell with the donor and lot numbers will be arrayed.  Clicking on any of these cells will display 
the full information for that cell above the array.  Out-of-date cells will have the lot number 
highlighted in red and frozen cells will have the lot number highlighted in blue. 
 
If an antigen pattern or additional antigen shows “0 Matches Found” and you are sure that the 
pattern or antigen exists, it may be because the cell’s blood group does not match, or the cell is 
marked Out of Stock and the System Options|Exclude From Searches box is checked. 
 
Each time a match is found, the cell is displayed below.  Any change to the search criteria 
(changing any search antigen button or changing the search additional antigens box) will reset the 
search procedure, and the data will be searched starting at the beginning. 
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Selecting 
 
Whenever you are in the Search mode (the search pattern box is present) and a cell is displayed 
below, you may click the Select box to tag this cell with a checkmark or to erase an existing 
checkmark.  If you click Select All Matches, all the cells displayed will be selected.   Cells with a 
checkmark are included on Selected Cell and Results Worksheet panels. When duplicate cells are 
selected, they will be highlighted in yellow so that they may be easily de-selected...  There is no 
limit to how many cells you may select, however the search preview screen can only display up to 
13 cells at a time (6 if the screen is minimized) and a printed selected panel can only print up to 
16 cells on a page.  The results worksheet screen can only display up to 15 cells at a time.  You 
may scroll to subsequent preview screens and all cells selected will print on consecutive pages.  
To empty the Selected and Results panels without exiting the program, remove ALL checkmarks 
by selecting the Clear Selected Cells button. 
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Selecting	Expired	Cells	
 
Whenever you select a cell (or cells) with an expiration date that has passed, a dialog box will 
appear allowing you to select that cell (or cells) to enter the results of testing to ensure that cell is 
still reactive for the specific antigens in question.  You may enter the result for any or all of the 
positive antigens on that cell and those results will be maintained with the date of the test and the 
name of the tester.  You may opt out of this process by selecting Close and the cell will still be 
selected. 
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Previewing	a	Selected	Panel	
 
You may preview your selected panel on the screen by selecting the Preview Selected Cells Panel 
button.  Before previewing your panel, however, you should choose the order in which you want 
them previewed and printed.  This is done from the System Options menu.  If you choose Sorted 
by Expiration Date, the cells will start with the most recent and end with the frozen cells selected.  
The frozen cells themselves will be displayed in Donor ID/Lot number order.  If you choose In 
Order Checked, the cells will appear in the order in which you selected them during the search.   
If you choose Sorted by Donor/Lot, the cells will be displayed by Donor ID/Lot number order.   
The same order choice will govern your printed worksheet and will remain in effect until you 
change it from the Options menu.  The selected cells will be displayed 15 at a time.  The 28 
principal antigens are displayed in the Display Option order you have selected on the search/entry 
screen. 
 

Patient	Information	
Information about patients that will display on the Search screen and remain with saved work-ups 
is entered either on the Search Screen or in the View menu.  On the Search screen, open the 
Select Patient drop down menu and select a patient to modify, or fill in a new ID, name, and 
optional date of birth and short note and press Add.  
 
You must enter an ID for the patient that will 
uniquely identify that patient.  The 
nomenclature or protocol is up to you.  The 
patient ID will display on the screen whenever 
you call that patient up from the Search 
screen.  If you enter a patient name and 
information in the Short Note, that will also 
appear on the screen.  Saving any work-up 
with a particular patient on the Search screen 
will attach that information to the printed 
worksheet as well as the saved lot table.  
Patient information can be also entered or 
edited in the Maintain Patients table that is 
found in the View menu. 
 
 
Clear All Selected Cells 
 
This button option on the Search screen will clear all the cells currently selected and there will be 
zero cells selected.  Unless the Selected Cells or Results Worksheet has been saved, no results 
will be retained.  A warning will appear confirming the intention to discard the current work. 
 
 
 

	

Save	Selected	Panel	
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As soon as any test result is entered, the Save Selected Panel option is disabled unless a patient 
has been selected, or the user has loaded a saved panel. 
 
To save the currently selected panel: 
Open the Panel menu and select the Save the Selected Cells Panel option or from the File menu 
on Selected Cells or Results Worksheet select Save Panel.   A new screen will appear showing 
current data to be saved with the worksheet: 
 
You may add a description of unlimited length to the saved panel in the Full Panel Description 
text box.  When you are ready to save the panel with or without an extended description, press 
Save.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A previously saved panel may be revised and saved again using the same panel number.  
The older iteration(s) of the panel will remain associated with this panel and may be 
recalled (but not altered) from the View/Panel history screen on the Results Worksheet.  
Save dates, technologists 
and reviewers will be 
listed on the history. 
 
For a list of which 
technologists entered 
which results go to  
View | Technologists 
screen on the Results 
Worksheet 
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To delete a saved panel: 
Select a panel in the Load Saved Panel menu and click Delete.  The delete button will not be 
active until ten years have passed since the saving date. 
 
 
 
 

	

	
 

	

	

Load	Selected	Data	
 
To load a saved panel: 
Open the Panel menu and select the Load Saved panel option.  The Load option is disabled unless 
there is at least one saved panel.  A new screen will appear: 
 
 
 
  Click on a row and click the Load 
button.  This will add the panel you have 
selected to the Selected Cells and Results 
worksheets.  Loading a saved panel will 
empty the Selected Cells and Results 
screens of any previously entered data.  
Once a saved panel is loaded, additional 
cells may be added to the Selected Cells 
and Results screens by using the Search 
function. 
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Selected	Cells	Worksheet	
 
The Selected Cells Worksheet is a worksheet containing all of the cells with check marks on 
them. Once you have selected the cells you want, it may be called up from the Panel Menu. The 
cells are displayed in your choice of Expiration Date, Checked, or Donor ID / Lot and vial order.   
The 28 principal antigens are displayed in the Display Option order you have selected in System 
Options.  If a patient has been selected with the Selected Panel, the patient information will 
display on the worksheet.  Additional antigens appear to the left of the principal antigens.   If a 
selected cell has an expiration date prior to the system date, the cell’s first column will be marked 
OOD (Out of Date).  If a selected cell is Frozen, the cell's first column will be marked FZN.  The 
Selected Panel Worksheet may be printed at any time by selecting File/ Print at the top left of the 
screen.  If there are more additional antigens than can print on one line, more lines will be 
inserted underneath the cell until all additional antigens are printed. The worksheet will display 
the date and time it was printed. If a patient has been selected with the Selected Panel, the patient 
information will display on the print-out.  The Selected Panel Worksheet prints out with eight 
blank columns on the right for manually entering test results and additional blank rows beneath 
the last selected cell to the end of the page.  A blank worksheet may also be printed from the 
Panel menu: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
De-selecting a Selected Cell 
 
A cell may be removed from the selected panel preview screen by clicking on the checkbox in the 
Selected row (the cell will not be deleted from the system).   
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Evaluating	Test	Results	

  
The Results Worksheet may be called up from the Panel menu whenever selected cells are 
present. Any antigens that cannot be excluded by the current selection are highlighted in the 
Count rows at the bottom of the screen.   Results can be recorded as they are read by 
clicking in the box in the appropriate test column that is in the same row as the tested 
cell.  The test column box will be highlighted and a drop down box will appear with a 
choice of results that may be entered by clicking on the desired number.  The default 
choice is 0 through 4+ (Agglutination Grading).  Result choices may be seen and 
entered in the Marsh 0 to 10 scale by choosing that option in the System Options menu.   
If you are entering results in a column that requires a check cell entry, the check cell 
box will appear each time you enter a negative result.  You must confirm that negative result by 
entering a positive result in the check cell box. Once a choice is entered, move the cursor down to 
the next tested cell and repeat the procedure.   
 
The number of homozygous and heterozygous rule-outs for each antigen appear in the Count 
rows below the cell rows and above the Evaluation that specifies which antigens remain to be 
excluded.  Antigens that 
cannot be excluded with 
the cells currently selected 
are highlighted in the 
Count rows. 
 
The Results columns 
default to IAT, ENZ, 
DTT, and A, B, C, and D 
respectively.  A, B, C, and 
D columns exclude by the 
same rules as IAT, and 
those columns may be 
renamed and all the 
columns may be repositioned from the Options Menu.  Names are suggested for the columns but 
you may type any text in the column header box that you choose.  Check cell status may be 
selected for the optional columns and the check cell threshold for all columns may be set. 
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To remove a result from a box, click once on the box, then click on the blank space above the 
zero in the choices box.  As the results are entered, the excluded antigens are shaded and the 
exclusions obtained will appear in the Evaluation box at the bottom of the screen.  The bottom 
line of the Results Panel, “Rule Outs”, keeps a running tally of the number of times an antigen 
has been excluded either by homozygous or heterozygous results. 
 
Exclusions are specific to the results column in which they are entered and are so marked.  The 
basis for those exclusions is documented below in the Exclusion Policy section.  Results and  
exclusions are maintained as long as the selected cells are not cleared.  If the Selected Cell 
Worksheet or Results Worksheet is saved, any results entered against those cells will be saved 
with the panel and will appear on the Results Worksheet screen when the Saved Panel is loaded.  
If more cells are required for testing than appear on the Results Worksheet screen, simply select 
the Search screen from the task bar by clicking on the Antigen Plus icon (or exit the Results 
screen by clicking the X button in the upper right corner of the screen) and add cells to the 
Selected Cell Panel by the Search methods.  The current Evaluation box will appear at the bottom 
of the Search screen.  Any new cells selected will be present on the Results Worksheet screen 
when it is called up again.   
 
A Results worksheet may be printed at any time by clicking on the Print button.  If any cell has a 
long list of additional antigens obscuring the test columns, the Additional Antigen column may be 
compressed by moving the cursor on top of the left hand border of the shaded title bar of the 
Additional Antigens column—the cursor will change to a two-headed horizontal arrow—holding 
the mouse clicker down and dragging the border to the right. The additional antigens will be 
hidden and the test columns will be visible without scrolling to the right of the screen.  An Auto 
Cell row will appear as the last cell of any Results panel.  The Auto Cell will have blank boxes in 
each column.  If typings are known for the Auto Cell, they may be entered on the Results screen 
and will be saved and may be recalled if the Selected Cells Panel is saved.  Test results may be 
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entered for the Auto Cell but those results will have no effect on the evaluation.  If a positive test 
result is entered for the Auto Cell a warning will appear in the Evaluation box. 
 

 

Reviewing	a	Saved	Panel	
 
Once a result or results have been entered in a Results Worksheet and the worksheet has been 
saved, a user with appropriate privileges may review it.  After a panel has been reviewed, no 
further changes may be made to the worksheet, unless the reviewer unchecks the review box.  
Only the user who reviewed a panel or an administrator can remove the review from that panel. 
 

 
A user with “full-user” privileges may only review a panel on which that she/he has not entered 
any results i.e. only review someone else’s work.  An administrator may review her/his own 
work. 
 
A second review may be entered after a first review following the same rules.  If anyone changes 
reviews on a saved panel, a prior iteration of the panel will be maintained with the original 
reviews in Panel History. 
  

Printing	
 
Print and Print Preview menus are accessed from the file menus of the Selected Cell or Results 
Worksheets.  Antigen Plus should ensure that your printer prints in Landscape (11 x 8½) format.  
If your print out appears in Portrait format, you may correct this in Windows by minimizing the 
Antigen Plus program, then invoking the Start, Settings, and Printers commands, and setting up 
the printer. When you are finished, reactivate Antigen Plus by clicking its icon at the bottom of 
the screen.  

Data	Entry	
 
Antigen Plus allows the entry of unique cells and/or lots from suppliers other than those currently 
licensed by the FDA to sell red blood cell panels in the United States.  Most hospital transfusion 
services will rely solely on commercial suppliers and entry of red cell data may never be 
necessary or may be restricted to adding or correcting a typing on an existing cell.  Complete red 
cell phenotype data entry is described at the end of this section.  The user may make changes to a 
supplier’s donor phenotype based on additional typing by calling up the donor on the Add/Edit 
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screen, entering the changes (reactions, special typings etc.), and clicking the Save button.  These 
changes will not be maintained for the donor in any subsequent lot, so it is strongly recommended 
that you note the change in the Donor Note, which will remain with the donor regardless of lot. 
 

Donor	Note	
 
An optional note may be stored with each Donor ID by selecting Donor Note from the View 
menu when the donor is displayed in the Donor ID box.  Type your note in the Donor Note text 
box and then select Save and Close. 
 
 
 
 
 
 
 
 
A Donor Note is associated with the Donor ID only, not the Lot, so it will appear with every Lot 
that a donor ID is in.   When a Donor ID has a note on file, that information will be displayed 
whenever that donor is on the Add/Edit or Search screens. 

 
 
 

Data	Entry	of	Individual	Cells	
 
 
Data may be entered or changed in a box whenever the cursor is positioned over that box.  The 
cursor can be moved to another box by pointing to it with the mouse and clicking the left mouse 
button.  The cursor also moves to the next box by pressing the Tab key, or to the previous box by 
pressing the Shift + Tab keys.  Previously saved data can be viewed and selected by clicking the 
little down-arrow to the right of the box, or by pressing the Ctrl + Down Arrow keys while the 
cursor is in the box.  The box will be “opened”, and the data will be displayed in numerical and 
alphabetical order.  Any item in the list can be selected with a mouse click, or by highlighting it 
with the Up or Down Arrow keys and pressing Enter. Alternatively, items can be scrolled without 
opening the box by pressing the Down Arrow key.  A list box may be opened at a particular spot 
in the list by first entering a character or characters in the box and then opening it.  A button may 
be activated or “pushed” by clicking it with the left mouse button, or by moving the cursor to the 
button and pressing any key.  You can tell when the cursor is on a button because its outline 
becomes darker, and if it has writing on it, the writing is surrounded by a dotted line.  As with 
boxes, the cursor can be moved from button to button by using the Tab or Shift + Tab keys, or by 
clicking directly with the mouse.  In general, the cursor moves from left to right and top to bottom 
on the screen.  A donor cell is identified by its Donor ID and Lot Number.  A donor number or lot 
number may appear any number of times, but the Donor ID - Lot Number combination must be 
unique.  In order to save a cell in the database, it must have a non-blank Donor ID and a non-
blank Lot Number.  When you are entering several cells from a single antigram or lot panel, the 
data boxes are blanked after you Save, but remain indexed at the last item entered.  Therefore, 
when you enter one cell and save it, then enter a new Donor ID number, you can Tab to the Lot 
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Number box and press the Down Arrow to recall the previous Lot.  Its expiration date and 
supplier will also appear, saving you from having to re-enter the data. 
 
 
 
 
Donor Number 
 
The Donor No. box will accept up to 16 characters and may be any 
combination of capital letters and characters except apostrophes.  Enter a 
donor ID and press the Tab key to move on to the Lot Number box. If the 
donor is already on file, the cell data will be retrieved and displayed. 
 
 
 
 
 
 
 
 
 
 
 
 
Drop-down (or list) boxes have a scroll bar.  One donor may be present on several different 
panels.  If a donor has more than one cell on file, and her previously existing ID is entered, the 
most recent one found will be displayed.  This is to facilitate entering duplicate donors - when 
you wish to enter a donor who is already on file into a new lot number, the old phenotype will 
automatically appear, and you then need to enter only the new lot number, check the expiration 
date, and click the Save button.  It is assumed that the phenotype will not have changed from a 
previous panel. 
 
Lot Number 
 

The Lot Number is used to show the supplier's unique 
 lot number for this cell's panel. All cells with a given Lot  
Number will have the same supplier and expiration date. 
 
The Lot Number box will accept up to 16 characters 
 and may be any combination of numbers and capital  
letters. Enter a lot number and press the Tab key to move 
 on to the Vial box.  If the lot number was already on file,  
the expiration date and supplier will be retrieved and displayed. 
 
 
 
 
 
Vial 
 
The Vial box will accept any number from 0 through 99.  It will also accept a TC (tech cell) vial. 
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Enter a vial number or TC and press the Tab key to move on to the Expires box.  Pressing the Up 
and Down Arrow keys or clicking the little up and down arrows to the right of the box will 
automatically raise or lower the displayed vial number. TC is located below the 0. 
 
 
 
 
Expiration Date 
 
The Expires box is for the expiration date of all cells in the lot number displayed.  You may enter 
a date in any format that is comfortable for you, such as “20 Dec 10” or “12-20-11”, then press 
the Tab key to move on to the Supplier box.  The date will be re-displayed in the format set in the 
Windows Control Panel/Regional Settings/Date function.  If the date is before the present system 
date, a bright red Out of Date! will appear under the Expires box.  The expiration date is stored 
with the lot number, so if you change the expiration date of a lot number, then ALL cells with 
that lot number will have the new expiration date. 
 
Supplier 
 
The Supplier box is populated with default commercial suppliers and any that you have added in 
the Suppliers table found in the View menu.   
When a supplier is changed in the Supplier box, 
the antigen array below will change to match that 
Supplier’s array. 
 
 
The supplier is stored with the lot number, so if you change the supplier of a lot number, then 
ALL cells with that lot number will have the new supplier. 
 
Location 
 
Enter a storage drawer location for a frozen cell.  The location is stored independently and will 
not affect other cells with the same lot number--should there be any.   The Location box will 
accept up to 64 characters in any combination of letters and numbers. 
 
 
Rh-Hr 
 
Antigen Plus comes with the standard Rh-Hr phenotype designations loaded in the drop down 
box that is activated by clicking on the down arrow adjacent to the Rh-Hr entry box.   Choosing 
one of these designations by clicking on it will place it in the entry box and will mark the 
appropriate pluses and negatives in the Rh-Hr antigen group.  If changes are made to that antigen 
group, the RhHR phenotype will be cleared when the cell is saved.  A user may save the cell 
again with the proper phenotype or leave it blank. 
 
Note: Antigen Plus no longer specifies the Cw antigen in Rh-Hr designations since we cannot 
predict 100% when C will be on the same gene complex as Cw. 
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Additional	Antigens	
 
The Additional Antigens box consists of an entry box, check boxes, and a display box directly 
above them containing this cell’s additional antigen phenotype.  You may enter an additional 
antigen in the Add New entry box, or select one from the list by clicking the box.  To add what is 
in the entry box to this cell, check the box.  To remove an antigen from a cell uncheck the 
appropriate box. 
 

 
 
There is no limit on how many additional antigens you may enter. However, once the screen 
space is used up, further antigens will be stored but not displayed.  When there are more 
additional antigens than can be displayed on a Lot Panel print out, an ellipsis (“...”) at the end of 
the additional antigen list (displayed alphabetically) will indicate the presence of the additional 
typings.  Mousing over the 
display all of the antigens 
present along with their 
associated ISBT numbers.   
 
A table of ISBT numbers 
used in Antigen Plus can be 
found in the Appendix. 
 
 
 
 
The reason for the entry-box 
method of adding additional antigens is to ensure consistency: you must be consistent in your 
notation in order for a search to work properly. For example, to indicate a Colton b antigen (Cob) 
as positive, you may enter Co(b+), CoBPos, or any other notation that is 8 characters or fewer, 
but you should use the exact same notation for all cells with this antigen. The entry box will 
contain a list of all the additional antigens previously saved in your inventory, and you should 
check for an antigen’s presence before entering a new one.  The ISBT numbers can be consulted 
for more precision in nomenclature.  A table of ISBT numbers used in Antigen Plus can be found 
in the Appendix. 
. 
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Out	Of	Stock	
 
To mark a cell as exhausted, click the Out Of Stock button, click OK in response to the pop-up 
query, and then click the Save button.  The data will remain on file so that you can recall the 
phenotype in case the cell shows up in a new lot, and will remain in any saved panels. The cell 
will not be available in the search process unless you mark the Include in Searches feature in the 
Out of Stock Inventory box in the System Options menu.  When you click the Save button, you 
will be given the option of marking the entire lot as out of stock.  Click Yes or No in the popup 
window, or type y or n, to indicate your choice. Please note: If you do not click the Save button 
after marking the cell as out of stock, the cell will remain in stock and the out of stock flag will 
not reappear on the screen when that cell is recalled. 
 
Sex 
 
Clicking the Sex button will change the button from blank to M to F. This is optional information, 
and not normally of significance in the selection of panel cells. 
 
Group 
 
The Group button allows you to enter the blood group of the donor cell.  Since most commercial 
panel cells are group O, that is the default setting.  To change the blood group to A, B, or AB, 
click the Group button until one of those characters appears.  To leave the blood group 
unspecified, click the Group button until a blank appears. 
 
Frozen 
 
Click the Frozen box to mark a cell as frozen. The expiration date will be blanked.  Frozen cells 
will be found last in the search process, since searching is done starting with newest cells first. 
 
Antigens 
 
The 28 principal antigens are displayed with colored labels for easy identification.  When you are 
entering a new cell, all the antigens will have a 0 setting.  You may change a setting to a +, s, w, 
or blank by clicking the button with the mouse pointer (right and left mouse clicks scroll through 
the choices in opposite orders), or by moving to a button with the Tab key and pressing any other 
key.  A blank setting indicates that no information is available.  For example, some suppliers may 
not include the Kell system Kpb and Jsb, so you may blank these antigens’ buttons. 
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Save 
 
Clicking the Save button will save all the cell data displayed for the unique Donor No. - Lot 
Number combination.  Any items not previously present in the data boxes (Donor, Lot, 
Expiration Date, Supplier, Additional Antigens, and RhHr) will be added to the lists in those 
boxes.  The cell display is cleared and the cursor returns to the Donor No. box.  The Lot Number, 
Expiration Date, and Supplier are saved as a group with the Lot Number.  If you have changed 
the date or supplier of a lot, then ALL cells with that lot number will have the new date and 
supplier.  A Donor Note is saved only with the Donor ID, and stays with the Donor ID regardless 
of which Lot it is in. 
 
Delete 
 
Clicking the Delete button will prompt you to make sure, then remove the displayed Donor No. – 
Lot Number combination from your inventory as long as it has not been used in the last ten years 
in any saved work.  When a cell is deleted, any unique lot, additional antigen, or RhHr 
information it may have had will also be deleted from the lists in those boxes. 
 
Delete Lot 
Clicking the Delete Lot button will prompt you to make sure, then remove ALL cells with the 
displayed lot number (the ten year rule applies). 
 

Multiple	User	Procedures	
 
There is no restriction on the number of users who can use Antigen Plus and share its 
data at the same time.  There are, however, some default rules of precedence in cases 
when new data are added to the system by one of the users and where the same data are 
altered and saved by more than one user in a session.  Your SOP should make note of the 
following rules: 
 
When a user downloads a new lot into the system, the cells within the lot that lot will be 
available for searches by other users and will appear in the Maintain Lots screen, but will 
not be available in the Lot drop down list on the Search or Add/Edit screens until the 
other user clicks the Refresh Data option in the File Menu (or simply presses the F5 key). 
 
If two users have the same saved panel open, the second one to save will be the current 
panel iteration even if the first user has changed and/or reviewed the panel.  The first 
user’s panel will be available as a prior iteration, but will have to be recreated to be a 
current one (this can be done by opening the current iteration and making the necessary 
changes using the prior iteration as a guide).  However, the first user’s saved panel will 
appear immediately on the Panel History screen, so to ensure that there are no conflicts, a 
user who suspects that there may be someone else working on the same panel can check 
the panel history before saving his/her work. 
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Exclusion	Policy	
Antigen Plus - Ab ID excludes antigens in the manner described by the AABB Technical Manual, 
15th Edition, (Ch. 19: pg. 428-9).  Homozygosity is required for the exclusion in the following 
blood group systems: Rh, Duffy, Kidd, MNS.  In the presence of anti-D, the program will exclude 
E and C on heterozygous cells.  Blank antigens will cause the known positive antithetical partner 
to be considered heterozygous for exclusion. The blank antigens themselves are not considered 
positive or negative and will not be considered for exclusion. 
 
The	blood	group	antigens	that	can	be	excluded	on	heterozygous	cells	are	K,	Kpa,	Jsa,	and	Lua.	
The	program	will	not	exclude	K,	Kpa,	or	Jsa	on	heterozygous	cells	if	a	homozygous	expression	of	
the	pair	on	the	same	panel	is	reactive.	As	the	Homozygosity	of	P1	and	Xga	is	not	easily	
determined	from	most	panel	sheets,	the	program	requires	3	examples	of	each	antigen	to	be	
non-reactive	with	the	patient	sample	before	it	will	exclude	either	antigen.			
 
It is always advisable to review AABB Technical Manual, 15th Edition, (Ch. 19: pg. 429-36) for 
more detailed information on Complex Antibody Identification including variability of antigen 
strength, the effect of storage on RBC antigens and use of autologous cells while considering the 
antigens excluded or not, by the program. Any final decision made by the technologist must be 
consistent with their facility SOP for Antibody Identification. 
 
The program does not encompass the knowledge of all blood group systems and their patterns of 
reactivity.  Any technologist using the program to automate the exclusion process must apply 
serological expertise to interpret the program’s lists of antigens excluded versus antigens not 
excluded.  The program evaluates each column of reactivity independently.  Exclusions obtained 
from the results recorded in columns A, B, C, and D will be exactly the same as those obtained 
from identical results recorded in the Liss indirect antiglobulin test (IAT column).  There is too 
much variability in antibody reactivity to risk excluding an antigen on anything but the reactions 
obtained by the technologist and recorded in Antigen Plus - Ab ID.   
 
Red cell treatments, when performed correctly, do have a standardized effect that is well 
documented.  Antigen Plus - Ab ID does employ that information when the ENZ column and 
DTT column have results recorded in them.  The ENZ column will not exclude Duffy and MNS 
blood group system antigens. The DTT column will not exclude Kell or Lutheran blood group 
system antigens. 
 
High frequency antigens and low incidence antigens, which can be used as a search parameter to 
select cells for the results panel, cannot be used in the exclusion process or listed in the 
Evaluation box at the bottom of the results panel. As the antigens listed in the Additional 
Antigens are entered by the individual user, they are not pre-coded by the program. A list of 
technical tips to assist any technologist who may have an antibody to a high frequency antigen or 
to a low incidence antigen is included in the Help utility and is reproduced on the following 
pages. 
The following text always appears with any results in the Evaluation box. 
 
These are tentative rule-outs. 
 
Additional confirmatory data based on your own criteria are recommended. 
 
It is the user's responsibility to record accurate test data and to confirm that data according to 
established protocols. 
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Technical	Information	for	Further	Testing	
1.  If all cells in the first panel are reactive and the autocontrol is negative, try chemically treated 
screen cells and see if this alters the reactivity in any way.  Chemical treatment of red cells 
includes: enzymes, DTT, AET or CDP (chloroquine diphosphate).  Methods and information on 
obtaining any of the products required, can be found in the American Red Cross 
Immunohematology Methods and Procedures, D. Mallory, ed.  Selecting 2 or 3 cells from the 
panel, or using the screen cells, will save time, save plasma and still provide new information.  If 
the information is that nothing changed, go to step 2. 
[More information on the actions of specific chemicals is listed in step 2, (iii).] 
 
2.  If all cells in the first panel tested are reactive and the auto control is negative, perform a 
common phenotype on the patient's red cells (patient must not have been transfused in the 
preceding 90 days).  Blood group systems to include Rh, Kell, Duffy, Kidd and MNS. Select a 
cell from any of the panels or screen cells in your inventory that is negative for the same antigens 
the patient lacks and test it.  This is referred to as running a phenotypically matched cell. 
 
EXAMPLE:  PATIENT  D+C+E-c+e+, K-, Fy (a+b-), Jk(a-b+), M+N+S-s+. 
POSSIBLE MATCHES: D-C-E-c+e+, K-, Fy(a-b-), Jk(a-b+), M-N+S-s+ 
D+C+E-c-e+, K-, Fy(a+b-), Jk(a-b+), M+N-S-s 
 
i)  If the phenotypically matched cell does not react with the patient's plasma, select a panel of red 
cells based on one example of each antigen to be excluded per cell.   
 
EXAMPLE: FOR THE PATIENT LISTED ABOVE THE SELECTION CRITERIA 
WOULD BE: 
CELL 1 E+, K-, Fy(b-), Jk(a-), S-. 
CELL 2 E-, K+, Fy(b-), Jk(a-), S-. 
CELL 3 E-, K-, Fy(b+), Jk(a-), S-. 
CELL 4 E-, K-, Fy(b-), Jk(a+), S-. 
CELL 5 E-, K-, Fy(b-), Jk(a-),  S+. 
This will confirm or exclude which antibody(ies) to the common antigens the patient has formed 
and what is left to form in the future. 
 
ii)  If the phenotypically matched cell(s) is reactive with the patient's plasma and the 
autocontrol is negative, the most probable cause is an antibody to a high frequency antigen. 
Use Antigen Plus to select any examples of high frequency antigen-negative red cells 
in your cell library. I.e... At(a-), k-, Kp(b-), Js(b-) etc. 
iii)  If you have a limited rare cell library or failed to obtain a negative reaction with the high 
frequency antigen-negative red cells available, consider that various red cell treatments which 
modify or destroy certain antigens on red cells can also be useful.  DTT/AET treatment will 
destroy: Kell (not Kx), Lutheran, Knopps/McCoy, Cartwright, Cromer, Dombrock, Auberger, 
JMH and Lwa. Gerbich is destroyed by DTT but not AET.  ENZYMES (papain, ficin, trypsin, 
bromelin) will remove: Duffy, MNS, Chido, Rogers, JMH, Gerbich, Gilfeather, Xga, Pr, Vw, 
Cartwright, Mia, Cla, Jea, Nya and most Ena.  Chloroquine diphosphate (CDP) will destroy Bg and 
class I HLA antigens. 
 
3.  If all cells in the first panel tested are reactive and the auto control is positive, do a direct 
antiglobulin test (DAT) on the patient's cells before doing further serum testing. 
 
 
i)  If the DAT is positive, a warm autoantibody should be suspected and may hide underlying 
alloantibodies in the patient's plasma.  The autoantibody should be removed by autoabsorption 
before further antibody identification can be achieved.  Autoabsorption can only be performed 



41 
 

using pre-transfusion patient red cells.  The patient must not have been pregnant or transfused in 
the preceding 90 days.  For further information and testing methods, refer to the AABB Technical 
Manual, Current Edition, or the American Red Cross Immunohematology Methods And 
Procedures, D. Mallory, ed. 
 
ii)  If the DAT is negative, a cold autoantibody should be considered.  A cold screen tested from 
room temperature down to 4o C will indicate if an autologous absorption done at 4o C will be 
useful to remove the autoantibody.  Again, the patient must be untransfused in the preceding 90 
days. 
 
iii)  If autoabsorption, warm or cold, is not possible, there are alternatives.  Allogeneic warm 
absorption is possible using R1R1, R2R2, and rr cells.  A prewarm method may be useful to 
remove any cold reactivity.  Prewarm methods must be used with caution preferably after the 
clinically significant antibodies have been tentatively identified.  Prewarm methods have been 
documented to remove anti-H activity in a Bombay phenotype and an example of anti-Vel. 
References on request.  
 
4.  If all the cells tested are negative, several things must be considered: 
 
i)  Repeat the cell that gave the original positive reaction that initiated the panel, i.e. the antibody 
screen test or one of the units being crossmatched.  Note where the antibody reacts - immediate 
spin or IAT?  Was the panel tested at the same phase the reaction occurred in? 
 
ii) How soon after the original testing, was the panel performed?  Was the sample stored 
properly? 
iii)  Is the reactive cell homozygous for any common antigen and is there another cell 
homozygous for the same antigen that can be used to repeat the result?   
      iv)  Will enhancement media help reveal a weak reacting alloantibody pattern, i.e. 
Enz, PEG, LISS with a longer incubation time, or polybrene? 
v)  If none of this adds any information about antibody specificity, you may have an antibody 
directed against a low frequency antigen.  While the identity of the antibody is a puzzle, it is 
rarely a significant problem when looking for compatible units of red cells for transfusion.  If you 
have time to play with it, use Antigen Plus to locate as many low incidence antigen positive cells 
as you have listed under special antigens.  If none of them react, and you still wish to resolve the 
specificity, send the sample to a reference lab for crosstesting.  Most reference labs keep their 
unidentified lows in hopes of finding another example. 
 
5.  If your routine test method can detect weak reacting autoantibodies at any phase of testing, 
positive antibody screen results can lead to a common panel result of several weak reactions with 
no specificity determined.  Antigen Plus will perform exclusions based on its policy and may well 
exclude all common specificities depending on the number of reactions and phenotype of the cells 
which do not react.  The technologist should follow his or her Blood Bank SOP for antibody 
identification which should address this type of panel testing outcome.  Depending on method 
used, patient population and number of occurrences, the most common choices are likely to 
include: 
i)  Try more sensitive method if an alloantibody may be just forming or was not stimulated in the 
recent past. 
ii)  Repeat the original test by a less sensitive method, e.g. from solid phase testing back to tube 
LISS-IAT (a common approach to dealing with the very sensitive capabilities of solid phase 
testing.) 
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iii)  Seen only at immediate spin – assess possible clinical significance and drop the IS test if 
appropriate. 
Use the prewarm method only after significant antibodies (anti-Vel, anti-PP1Pk, anti-H in a 
Bombay) have been excluded. 
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Backing	Up	
 
Your database is backed up on our Cloud server hosted by Microsoft Azure™.  Any problems 
retrieving data should be immediately brought to our attention at 
customerservice@antigenplus.com   
 

Additional	Information	

About	Antigen	Plus	
 
 Antigen Plus is written using Microsoft Visual Studio and SQL Server. It was designed for the 
reference laboratory by Michael W. Lankiewicz, M.D., a hematologist with an overworked staff, 
in order to save untold hours of searching and drudgery; and originally programmed by Peter 
Rowny, a blood donor, with additional improvements for the hospital transfusion service 
designed by Dawn M. Rumsey, ART (CSMLS) BB(ASCP)CM. 
 
 
COPYING TEXT FROM THE SCREEN 
The text in the Full description box on the Save and Load panel screens and the text in the Help 
screens can be copied into another application by highlighting the text by placing the mouse 
cursor at the beginning of the text to be copied, holding down the right mouse button and 
dragging the cursor across the text to be copied.  The text will be highlighted.  Release the mouse 
button and press the "Ctrl" and "C" keys on your keyboard simultaneously.  The text will then be 
copied to the Windows Clipboard and can be copied into any Windows application that has a 
Paste function. 
 
COPYING TEXT TO THE FULL DESCRIPTION BOX 
Text from the Windows clipboard may be copied into the Full description box on the Save screen. 
When the cursor is flashing in that box press the "Ctrl" and "V" keys on your keyboard 
simultaneously.  The text you have copied from another application will be pasted into the 
description of the panel and may be saved with the Panel Key name by clicking the Save button 
on the screen. 
 

Programming	Notes	
Antigen Plus is written in Visual Basic Studio and uses a SQL Server database.  Users familiar 
with SQL Server may open the databases and produce reports, run queries, and generally explore 
record layouts and file structure for purposes of importing data held in other databases.  Be sure 
to back up the original database before attempting any of these procedures. 

Appendix	
 
Guide to ISBT numbers used in Antigen Plus 
  
(taken from ISBT web site)  
 
http://www.isbtweb.org/fileadmin/user_upload/WP_on_Red_Cell_Immunogenetics_and/Updates/
Table_of_blood_group_antigens_within_systems_v3.3_131028.pdf 


